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About this Book and the Library

The User Guide provides conceptual information about Sentinel. This book also provides an overview
of the user interfaces and step-by-step guidance for many tasks.

Intended Audience

This guide is intended for Sentinel administrators and consultants.

Other Information in the Library

The library provides the following information resources:

Installation and Configuration Guide

The Installation and Configuration Guide provides an introduction to NetlQ Sentinel and explains
how to install and configure Sentinel.

Administration Guide

Provides the administration information and tasks required to manage a Sentinel deployment.

About this Book and the Library 11



12 NetlQ Sentinel User Guide



About NetlQ Corporation

We are a global, enterprise software company, with a focus on the three persistent challenges in your
environment: Change, complexity and risk—and how we can help you control them.

Our Viewpoint

Adapting to change and managing complexity and risk are nothing new

In fact, of all the challenges you face, these are perhaps the most prominent variables that deny
you the control you need to securely measure, monitor, and manage your physical, virtual, and
cloud computing environments.

Enabling critical business services, better and faster

We believe that providing as much control as possible to IT organizations is the only way to
enable timelier and cost effective delivery of services. Persistent pressures like change and
complexity will only continue to increase as organizations continue to change and the
technologies needed to manage them become inherently more complex.

Our Philosophy

Selling intelligent solutions, not just software

In order to provide reliable control, we first make sure we understand the real-world scenarios in
which IT organizations like yours operate — day in and day out. That's the only way we can
develop practical, intelligent IT solutions that successfully yield proven, measurable results. And
that's so much more rewarding than simply selling software.

Driving your success is our passion

We place your success at the heart of how we do business. From product inception to
deployment, we understand that you need IT solutions that work well and integrate seamlessly
with your existing investments; you need ongoing support and training post-deployment; and you
need someone that is truly easy to work with — for a change. Ultimately, when you succeed, we
all succeed.

Our Solutions

+ |dentity & Access Governance

+ Access Management

+ Security Management

+ Systems & Application Management
+ Workload Management

+ Service Management

About NetlQ Corporation 13
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Contacting Sales Support

For questions about products, pricing, and capabilities, contact your local partner. If you cannot
contact your partner, contact our Sales Support team.

Worldwide: www.netig.com/about_netig/officelocations.asp
United States and Canada: 1-888-323-6768
Email: info@netig.com
Web Site: www.netig.com

Contacting Technical Support

For specific product issues, contact our Technical Support team.

Worldwide: www.netig.com/support/contactinfo.asp
North and South America: 1-713-418-5555

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netig.com

Web Site: www.netig.com/support

Contacting Documentation Support

Our goal is to provide documentation that meets your needs. If you have suggestions for
improvements, click Add Comment at the bottom of any page in the HTML versions of the
documentation posted at www.netiq.com/documentation. You can also email Documentation-
Feedback@netig.com. We value your input and look forward to hearing from you.

Contacting the Online User Community

Qmunity, the NetlQ online community, is a collaborative network connecting you to your peers and
NetlQ experts. By providing more immediate information, useful links to helpful resources, and
access to NetlQ experts, Qmunity helps ensure you are mastering the knowledge you need to realize
the full potential of IT investments upon which you rely. For more information, visit http://
community.netig.com.
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1.2

1.3

Introduction to the Sentinel Interface

Sentinel is a Security Information and Event Management (SIEM) solution that receives information
from many sources throughout an enterprise, standardizes it, prioritizes it, and presents it to you to
make threat, risk, and policy decisions.

There are different tools to help you take advantage of all of the features Sentinel has to offer: You
must have necessary permissions to access these tools.

+ Section 1.1, “Sentinel Web Interface,” on page 15
+ Section 1.2, “Sentinel Control Center,” on page 15

¢ Section 1.3, “Solution Designer,” on page 15

Sentinel Web Interface

The Sentinel Web interface is the main user interface for viewing and interacting with Sentinel data.

For more information about the user interface and its options, see “Understanding Sentinel
Applications” in the NetlQ Sentinel Administration Guide.

Sentinel Control Center

Sentinel presents the collected data in the Sentinel Web interface as well as the Sentinel Control
Center (SCC). For more information on the Sentinel Control Center, see “Understanding Sentinel
Applications” in the NetlQ Sentinel Administration Guide.

Solution Designer

You can use the Solution Designer to package and export different contents, such as filters, reports,
searches, and Correlation rules with associated actions and dynamic lists. For more information on
Solution Designer, see “Solution Designer” in the NetlQ Sentinel Administration Guide.

Introduction to the Sentinel Interface
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2.1

2.1.1

Viewing Events in Real-Time

An event represents a normalized log record reported to Sentinel from a third-party security device,
network or application device, or from an internal Sentinel source. There are several types of events:
+ External events (events received from a security device) such as:
+ An attack detected by an intrusion detection system (IDS)
+ A successful login reported by an operating system
+ A customer-defined situation such as a user accessing a file
+ Internal events (events generated by Sentinel), including:
+ A correlation rule being disabled
+ The database filling up
Sentinel displays events in near real-time in a graphical and tabular representation. You can view and
analyze events in Real-time Views in the Sentinel Web interface and also in Active Views in the
Sentinel Control Center. Viewing events in Real-time Views enables you to view events without
having to log in to the Sentinel Control Center. To perform any event operations, you can launch the
Search interface. However, in Active Views, you can view the events and also perform event
operations in the Active Views table.
¢ Section 2.1, “Viewing Events in Real-Time Views,” on page 17

+ Section 2.2, “Viewing Events in Active Views,” on page 18

Viewing Events in Real-Time Views

To view events in Real-time Views, you must first create an event view.

The administrator can see all events in the system. The events other users see may be limited by a
security or tenant filter. For information about permissions to view events, see “Creating Roles” in the
NetlQ Sentinel Administration Guide.

Creating an Event View

To view and analyze events, you must first create an event view in the Real-time Views panel.
To create an event view:

1 Log in to the Sentinel Web console.

2 Click Real-time Views > Events > Create.

3 Specify the following information:
+ Name: Specify a unique name for the event view.
+ Sharing: Select either of the following options:

+ Public: Allow everyone to view the event view. In the Public mode, other users can
only view the events but cannot modify the event view. You are still the owner of the
event view.

Viewing Events in Real-Time 17


https://www.netiq.com/documentation/sentinel-73/pdfdoc/s73_admin/s73_admin.pdf#bpdemi7
https://www.netiq.com/documentation/sentinel-73/pdfdoc/s73_admin/s73_admin.pdf#bookinfo

18

2.1.2

2.2

+ Private: Only you are able to view the event view.
+ Criteria: Specify the criteria to view specific events.
+ Event Attribute: Select the attribute based on which you want to categorize the event data.

+ Tenant: If you are in a multi-tenant environment, select a tenant name for which you want to
view events. The default tenant allows you to view events from all tenants. If you select a
tenant, only users of that tenant can view the events in this event view.

This option is available only if you are an administrator in a multi-tenant environment.
+ Chart Type: Specify the chart type in which you want to view the event data.
+ Y Axis: Select either of the following options:
+ Event Count: Displays a graph with number of events for the specified time range.

+ Event Count per Second: Displays a graph with event rate for the specified time
range.

+ Time range: Select the time range for which you want to view the event data.
+ Display Interval: Select the time interval between two data points.
4 Click Save to save the event view configuration.

Viewing Events

To view an event view:

1 Click Real-time Views > Events.
2 Select the event view and click Open the event view.

Sentinel provides a graphical representation of events for the specified criteria. The chart
automatically refreshes after the interval specified in Display Interval.

As you are viewing event data, you can perform the following actions in the chart:

+ Mouse over the data points in the chart to view the number of incoming events or events per
second for a specific timestamp.
+ Click any category in the legend to filter the view by the legend items.

+ Click and drag the mouse to zoom the view for a specific time range.

The event view enables you to view only the summarized event data. To view the event details or
perform any event operations, you can do either of the following:

+ Click a specific area in the chart to open the Search interface with the list of events represented
in that area.

+ Click Search Events.

For information about viewing event details and performing event operations, see Section 3.2,
“Viewing Search Results,” on page 35 and Section 3.5, “Performing Event Operations,” on page 44.

Viewing Events in Active Views

Sentinel displays events in near real-time in Active Views tab in the Sentinel Control Center. As you
view events, you can also perform relevant operations on the events, including:

+ Create incidents or add the events to an exiting incident

+ For correlated events, you can view the events that triggered the correlated event
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+ Execute actions on the events
+ View the Advisor and asset data

For more information, see Section 2.2.4, “Managing Events,” on page 21.

NOTE: You must have the Create and use Active Views permission to view and manage events in

Active Views.

Accessing the Active Views Tab

When you launch the Sentinel Control Center, the Active Views tab is the first tab that is displayed. If

the Active Views tab is not displayed, you can access it by:

1 Log in to the Sentinel Web interface, then click Applications in the toolbar.

2 Click Launch Control Center.

3 Log in to the Sentinel Control Center as a user with Create and use Active Views permission.

The Active Views tab is displayed.

Active Views provides two types of views, which display the events in tables and graphs.

Table format displays the variables of the events as columns in a table. You can sort the information in

the grid by clicking the column name.

Graphical format displays events as graphs. You can change the chart types by right-clicking

anywhere in the chart and by selecting the desired chart type. You can also view the events that

match the filter criteria by right-clicking anywhere in the chart and by selecting the Drill-down option
from the menu. The events are displayed in the Sentinel Web interface.

The event table and the snapshot are the two types of Active Views.

Near Real Time Event Table: Displays the events in graphs with the following features:

+ Holds up to 750 events per 30-second period. If there are more than 750 events, the events are
prioritized to display correlated events first, then events that are sent to the GUI by using routing

rules, then all remaining events.

+ By default, the client maintains a 24-hour period of cached events. You can configure the time.

For more information, see Section 2.2.2, “Reconfiguring Total Display Time,” on page 20.

+ By default, the smallest possible display interval of an active view is 30 seconds. This is
represented by a gray line in the event table.

Figure 2-1 Gray Line- Indicating the Smallest Possible Display Interval

Severity EwvertTime

1/27TN2521:33 PM

XDASOutcomeMame

HKDAS_QUT_SUCCESS

HXDASTaxonormy Name

¥DAS_AE_QUERY_DATA_ITEM_CONTENTS

N/2712 5:21:33 FM

DAS_OUT SUCCESS

DAS_AE_QUERY _DATA_ITEM_CONTENTS

1/27TN25:21:24 PM

HKDAS_QUT_SUCCESS

HKDAS_AE_CREATE_SESSION

SIS SIC]

1/27M25:21:24 PM

HKDAS_OUT_SUCCESS

HKDAS_AE_AUTHENTICATE_ACCOUNT

If there are more than 750 events per 30-second time period, a red separation line indicates that
there are more events than are displayed.
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Figure 2-2 Red Line- Indicating More Events to Display

Sewverity EvertTime X¥DASOutcomeMamne — Tags
) 1/271M2 3:29:49 PM XDAS_OUT_SUCCESS Sertingl
[ 1/271M2 3:29:49 P XDAS OUT SUCCESS Sentinel
@ 172712 3:29:49 PM XDAS_OUT_SUCCESS Sertinel

+ When you save user preferences, the system continues to collect data for four days. For
instance, if you save your preferences, then log out and log back in the following day, your Active
View displays data as if you never logged off.

+ If an Active View is created and not saved, it continues to collect data for an hour. Within that
hour, if an identical Active View is created, the Active View displays data for the last hour.

Snapshot: Time-stamped view of a Real Event View table.
Several features make an Active View unique.

+ The filter assigned to an Active View
+ The z-axis attribute

+ The security filter assigned to a user

You can change event names to user-friendly names and the new names are populated throughout
the system. For more information, see “Renaming Event Fields” in the NetlQ Sentinel Administration
Guide.

2.2.2 Reconfiguring Total Display Time

Active View Properties allows you to configure the cached time in each client. The default cache time
value in an Active View is 24 hours.

To reconfigure the total display time:

1 Access the Active Views tab.

For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 In the menu, click Active Views > Properties.
3 Select the maximum display time, then click OK.

The new values do not take effect until you restart the Sentinel Control Center.

2.2.3 Viewing Real-Time Events

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 Inthe menu, click Active Views > Create Active View.
3 Use the following information to define the display properties:
Event Attribute (Z Axis): In drop-down list, select the desired attribute.
Filter: Specify the filter, or click the Browse button to select a defined filter.
Display Events: Select where to display event.
4 To customize additional settings, click Next, then continue with Step 5.
or
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To use the default settings, click Finish. The following default values are selected:
+ A display interval and refresh rate of 30 seconds
+ Total display time of 15 minutes
+ Y-axis as the event count
+ A chart type of Stacked Bar 2D

5 Define the statistical parameters:

Display Interval: Select the display interval. This is the interval to display events.
Refresh Rate: Select the refresh rate. This is the rate at which Active Views refresh.
Total Display Time: Specify the amount of time to display the chart.

Y-axis: Setthe Y axis to be either the total event count or event count per second.

6 Click Next.
7 Select your chart type from the drop-down list:

+ Stacked Bar 2D
+ Bar 3D

¢ Line

+ Ribbon

8 Click Finish.

The five buttons to the left of the chart perform the following functions:

Lock Chart or Unlock Chart: Used when performing a drill-down, zoom in, zoom out, zoom to
selection, and when saving a chart as an .html file. When you click the Lock button, you have
additional options:

*

*

*

*

Zoom In: Zooms in without changing any of the time settings of the chart.
Zoom Out: Zooms out without changing any of the time settings of the chart.
Zoom to Selection: Zooms in on a selection of time intervals of events.

Snapshot Active View: Saves an .html file with the chart as an image and events in a tabular
format.

Increase Display Interval: Increases the display time interval for incoming events.

Decrease Display Interval: Decreases the display time interval for incoming events.

Increase Display Time: Increases the time interval along the x-axis.

Decrease Display Time: Decreases the time interval along the x-axis.

Managing Events

In the table view, you can manage one or more events. Select the event or events you want to
manage, then right-click and select the option.

*

*

*

“Showing and Hiding Event Details” on page 22

“Sending Mail Messages about Events and Incidents” on page 22
“Creating Incidents” on page 23

“Adding Events to an Incident” on page 23

“Viewing Events That Trigger Correlated Events” on page 23
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+ “Executing Actions on Events” on page 24

+ ‘“Investigating an Event or Events” on page 24
+ “Accessing the Active Browser” on page 26

+ “Viewing Advisor Data” on page 27

+ “Viewing Asset Data” on page 27

+ “Viewing Vulnerabilities” on page 28

+ “Viewing User Information” on page 30

+ “Viewing the Targets” on page 30

+ “Managing Columns” on page 30

+ “Taking a Snapshot of a Navigator Window” on page 31

Showing and Hiding Event Details

To show details in a Real Time Event Table of the Navigator or Snapshot, double-click or right-click an
event, then click Show Details.

The details display in the left panel of the Real Time Event Table.

To close the Event Details window in a Real Time Event Table of the Navigator or Snapshot, right-
click an event, then click Show Details.

Sending Mail Messages about Events and Incidents

To send mail messages from within the Sentinel Control Center, you must have an SMTP integrator
that is configured with connection information and with the SentinelDefaultEMailServer set to True.
For more information on configuring the SMTP Integrator, see “Configuring Integrators” in the NetlQ
Sentinel Administration Guide.

To send an event message by e-mail:

1 In a Real Time Event Table, right-click an event or a group of events, then select Send Email.
The e-mail is sent to the specified recipients.

To e-mail an incident:

After you save your incident, click the Incidents tab, Incidents > Incidents View.

Click All Incidents in the Switch View drop-down list located at the bottom right corner.
Double-click an incident.

Click the Email Incident button.

a A W N P

Provide the following information:
¢ Email Address
+ Email Subject
¢ Email Message

6 Click OK.

The e-mail messages have .html attachments that address incident details, events, assets,
vulnerabilities, advisor information, attachment information, incident notes, and incident history.
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Creating Incidents

Creating an incident is useful in grouping a set of events together to indicate a pattern of interest,
such an attack.

You must have the View or create incidents and add events to incidents permission to create
incidents.

If events are not initially displayed in a newly created incident, it is probably because of a lag in the
time between display in the Real Time Events window and insertion into the event store. It takes a few
minutes for the original events to be inserted into the event store and displayed in the incident.

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 In a Real Time Event Table, select an event or a group of events and right-click.
3 Select Create Incident.
4 Follow the steps in Section 16.2, “Creating Incidents,” on page 143.

Adding Events to an Incident

You must have the View or create incidents and add events to incidents permission to add events to
Incidents.
1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 In a Real Time Event Table, select an event or a group of events and right-click.
3 Select Add To Incident.
4 Click Browse, then click Search to list the available incidents.

You can define your criteria to better search for a particular incident or incidents in the Select
Incident window.

5 Select an incident, then click Add.
6 Click OK.

If events are not initially displayed in a newly created incident, it is probably because of a lag in
the time between display in the Real Time Events window and insertion into the event store. It
takes a few minutes for the original events to be inserted into the event store and display in the
incident.

Viewing Events That Trigger Correlated Events

1 Access the Actives Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 In the Real Time Event Table, right-click a correlated event, then select View Trigger Events.

The View Trigger Events option is enabled only for Correlated events. “Viewing the Targets” on
page 30. The events that generated the correlation event are displayed in the Sentinel Web
interface.

Viewing Events in Real-Time 23



Executing Actions on Events

You can execute the following actions on events:

¢ Log to File

+ Log to Syslog

+ Send Email

+ Send SNMP trap

+ Send via Sentinel Link

1 Access the Actives Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.

2 In a Real Time Event Table, select an event or a group of events, right-click, then select the
action you want to execute.

Investigating an Event or Events

You can use the Active Views tab to investigate events in two ways:

+ You can perform an event query for the last hour on a single event for:
+ Other events with the same target IP address
+ Other events with the same source (initiator) IP address

¢ Other targets with the same event name

NOTE: You cannot perform a query on a null (empty) field.

+ You can graphically display the mappings between any two fields in the selected events. This is
particularly useful to view the relationship between the initiatiors (IP, port, event, sensor type,
Collector) and the targets (IP, port, event, sensor type, Collector name) of the selected events,
but any fields can be used
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The following illustration shows initiator IP addresses mapped to target IP addresses.

Figure 2-3 Graph Mapper
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+ “Using the Investigate Option for an Event Query” on page 25
+ “Using the Investigate Option with the Graph Mapper” on page 26

Using the Investigate Option for an Event Query
You can perform an event query within the last hour for events similar to the selected event.
1 In a Navigator or Snapshot window, right-click an event, then click Investigate and select one of
the options below:
Show More Events to this target: Events with the same destination IP address
Show More Events from this source: Events with the same initiator IP address

What are the target objects of this event?: Events with the same event name as the selected
event.

The chosen event information is displayed in the Sentinel Web interface.
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Using the Investigate Option with the Graph Mapper
To create a graph map:
1 In a Real Time Event Table, right-click one or more events, then select Investigate > Show
Graph.
2 Select the desired information in the From and To fields, then click Finish.
3 In the Graph Mapper window, select how the information is displayed:
¢ Circular
+ Hierarchical
+ Organic

*

Orthogonal

Accessing the Active Browser

The Active Browser provides the ability to browse through a selected set of data to look for patterns
and perform investigation. You can view the selected events in the Active Views in the Active
Browser. You can also perform all the right-click activities that are available in Active Views in the
Active Browser.

+ “Viewing Events in the Active Browser” on page 26
+ “Searching in the Active Browser” on page 26
+ “Adding Attributes in the Active Browser” on page 26

Viewing Events in the Active Browser

1 Access the Active Views tab.

For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 Select the events you want to view in the Active Browser.
3 Right-click the events, then select View in Active Browser.

The selected events display in the Active Browser window.

Searching in the Active Browser

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 Specify the value or text you want to search for in the Search field, then click the Search button.

You can move between the various searches by using the Forward and Backward buttons above the
search field.

Adding Attributes in the Active Browser

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 Click the Add an attribute for categorization button.
3 Select an attribute from the list.
4 Click OK.
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Viewing Advisor Data

Advisor provides a cross-reference between real-time intrusion detection system (IDS) attack
signatures and Advisor's knowledge base of vulnerabilities. The supported intrusion detection
systems are listed in “Detecting Vulnerabilities and Exploits” in the NetlQ Sentinel Administration

Guide.

To view Advisor data:

1 In a Real Time Event Table, right-click one or more events, then click Analyze > Advisor Data.

If the IDS AttackName field is properly populated, a report similar to the one below is displayed
in the Sentinel Web interface.

Advisor Report

Table of Contents:

Surnrmary
Details
Selected Events
Summary
Advisor. 299
TippingPoint,2176: SMEB: Mull Session Setlp CYE IDs: 1983-0519, 1953-0520
BugTrag IDs: Mo info found on this attack in the Advisor database

Details

Microsoft Windows NetBIOS Shares Access Control Weakness

Desecription:
Microsoft Windows NetBIOS Shares Access Control

Scenario:

Impact:
Loss Of Confidentialty Loss Of Integrity

Attack category:

Misconfiguration

Solution:

Patches:

Viewing Asset Data

4

Urgency

7

Severity

This feature allows you to view and save your view as an HTML file of your Asset Report. To view the
Asset data, you must run an asset management tool such as NMAP and bring the results into
Sentinel by using an Asset Collector. The available data for viewing are:

+ Hardware

*

*

*

MAC Address
Name

Type

Vendor
Product
Version

Value
Criticality
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*

Network
+ |P Address
+ Hostname
+ Software
+ Name
+ Type
+ Vendor
+ Product
+ Version
+ Contacts
¢ Order
+ Name
+ Role
¢ Emall
¢ Phone Number
+ Location
+ Location
+ Address

If both the Source IP and Destination IP are populated in an event, the asset data is displayed for
both. If either of them is populated, the respective asset data is displayed.

To view asset data:

1 In a Real Time Event Table, right-click one or more events, then click Analyze > Asset Data.
The Asset data is displayed in the Sentinel Web interface.

Viewing Vulnerabilities

Vulnerability Visualization provides a textual or graphical representation of the vulnerabilities of
selected destination systems. Vulnerabilities for the selected destination IPs can be seen for the
current time or for the time of the selected events.

Vulnerability Visualization requires that a vulnerability Collector is running and is adding vulnerability
scan information to the Sentinel database. The Sentinel Plug-in Web site provides Collectors for
several industry-standard vulnerability scanners, and additional vulnerability Collectors can be written
by using the Collector Builder.

NOTE: Vulnerability Collectors are distinct from Event Collectors and use different commands.

There are several Vulnerability Visualization views:

¢ HTML
+ Graphical
+ Circular

+ Organic

NetlQ Sentinel User Guide


http://support.novell.com/products/sentinel/secure/sentinelplugins.html

¢ Hierarchical
¢ Orthogonal
The HTML view is a report view that lists relevant fields, depending on which vulnerability scanner
you have:
* IP
+ Host
+ Vulnerability
+ Port/protocol
The graphical display is a rendering of vulnerabilities that links them to an event through common
ports. There are four available views:
+ Organic view
+ Hierarchical view
+ Circular view
+ Orthogonal view

The graphical display has four panels:

¢ Graph panel

+ Tree panel

¢ Control panel

+ Details/events panel

The graph panel display associates vulnerabilities to a port/protocol combination of a resource (IP
address). For example, if a resource has five unique port/protocol combinations that are vulnerable,
there are five nodes attached to that resource. The resources are grouped together under the
scanner that scanned the resources and reported the vulnerabilities. If two different scanners are
used, such as ISS and Nessus, there are two independent scanner nodes that have vulnerabilities
associated with them.

NOTE: Event mapping takes place only between the selected events and the vulnerability data
returned.

The tree panel organizes data in same hierarchy as the graph. The tree panel also allows users to
hide or show nodes at any level in the hierarchy.

The control panel exposes all the functionality available in the display. This includes:

+ Four different algorithms to display
+ The ability to show all or selected nodes that have events mapped to them
¢ Zooming in and out of selected areas of the graph

There are two tabs. When you are in the Details tab, click on a node displays node details. When you
are in the Events tab, clicking an event associated with a node displays a table in a Real Time
window.

To run a vulnerability visualization:

1 In a Real Time Event Table, right-click one or more events, then click Analyze and select one of
the following options:
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Current Vulnerability: Queries the database for vulnerabilities that are active (effective) at the
current date and time.

Event Time Vulnerability: Queries the database for vulnerabilities that were active (effective) at
the date and time of the selected event.

Viewing User Information

NetlQ provides optional integration with Novell Identity Manager. With this integration, user identity
information is added to incoming events when the account name matches one from Novell Identity
Manager. When the InitUserIdentity Or TargetUserIdentity column is populated in an event, a
right-click menu is enabled to open the user’s page in the Identity Browser.

When you right-click an event and select Show Identity Details, you can choose to view the identity
of the Initiator user, the Target user, or both. The Identity Browser opens and shows identifying
information about the user (or users) from the identity management system, all the accounts to which
the user is provisioned, and the recent activity by that user. For more information on the Identity
Browser, see Chapter 10, “Leveraging Identity Information,” on page 113.

Viewing the Targets
You can view the targets of the events in the Real Time Event Table.

1 In an existing Real Time Event Table, right-click an event, then click Target.
2 Select one of the following options:

* ping

+ Name server lookup

+ Trace Route

¢ Whois?

The selected information is displayed.

Managing Columns
You can manage the columns displayed in the Active Views tab.

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 Click Active Views > Event Real Time > Manage Columns.

3 Use the Add and Remove buttons to move column titles between the Available columns list
and the Show these columns in this order list.

4 Use the Insert button to insert an available column item into a specific location.

5 Use the up-arrow and down-arrow to arrange the order of the columns as you want them to
display in the Real Time Event Table.

The top to bottom order of column titles in the Manage Column dialog box determines the left to
right order of the columns in the Real Time Event Table.

6 To save your changes, click OK.

7 (Optional) If you want your columns to display the next time you open the Sentinel Control
Center, click File > Save Preferences.
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Taking a Snapshot of a Navigator Window
You must have user permission to take a snapshot.

A snapshot is useful to study events of interest because the Navigator refreshes automatically and
the alert or alerts of interest scroll off the screen. Also, within a snapshot, you can sort by column.

1 Access the Active Views tab.
For more information, see Section 2.2.1, “Accessing the Active Views Tab,” on page 19.
2 In the menu, click Active Views > Event Real Time > Snapshot.

A Snapshot window opens and is added to the Snap Shots folder list under Active Views in the
Navigator. The graphical display is not part of the snapshot.

To sort columns in a snapshot, click any column header once to sort by ascending value and twice to
sort by descending value.
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3.1

Searching Events

Sentinel provides an option to perform a search on events.You can search the local data in the
primary storage (/data directory) or the stored data in compressed format at the configured
secondary storage location.With the necessary configuration, you can also search system events
generated by Sentinel, and view the raw data for each event. By default, events are returned in a
reverse chronological order. This sort order relates to how the events are stored in the file system
partitions.

You can also search Sentinel servers that are distributed across different geographic locations. For
more information, see “Configuring Data Federation” in the NetlQ Sentinel Administration Guide.

¢ Section 3.1, “Running an Event Search,” on page 33

¢ Section 3.2, “Viewing Search Results,” on page 35

+ Section 3.3, “Refining Search Results,” on page 38

+ Section 3.4, “Saving a Search Query,” on page 39

+ Section 3.5, “Performing Event Operations,” on page 44

Running an Event Search

By default, the search results include all events generated by the Sentinel system operations. These
events are tagged with the sentinel tag. If no query is specified and you click Search for the first
time after the Sentinel installation, the default search returns all events with severity 0 to 5.
Otherwise, the Search feature reuses the last specified search query.

To search for a value in a specific field, use the ID of the event name, a colon, and the value. For
example, to search for an authentication attempt to Sentinel by user2, use the following text in the
search field:

evt:LoginUser AND sun:user2

An advanced search can narrow the search for a value to a specific event field. The advanced search
criteria are based on the event IDs for each event field and the search logic for the index. Advanced
searches can include the product name, severity, source IP, and the event type. For example:

¢ pn:NMAS AND sev:5

This searches for events with the product name NMAS and severity five.
¢ s5ip:10.0.0.01 AND evt:"Set Password"
This searches for the initiator IP address 10.0.0.1 and a “Set Password” event.
Multiple advanced search criteria can be combined by using various operators. The advanced search

criteria syntax is modeled on the search criteria for the Apache Lucene open source package. For
more information on building search criteria, see Appendix A, “Search Query Syntax,” on page 181.
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Performing a Search

To perform a search:

1

2
3

4

10

Log in to the Sentinel Web interface:
https://<IP _Address/DNS_Sentinel server:8443>

IP_Address/DNS_Sentinel_server is the IP address or the DNS name of the Sentinel server and
8443 is the default port for the Sentinel server.

In the Reports and Searches panel, click New search.
You can perform a search by using any of the following:
+ Search criteria: Specify the search criteria in the Search field.

For information on creating search criteria, see Appendix A, “Search Query Syntax,” on
page 181.

+ Add Criteria: Click Add Criteria and select from the criteria listed, click Add, and then click
Search. You can select criteria from the list of criteria or filter the criteria based on recent
criteria, tags, or filters.

+ Show recent criteria: Select a search criterion from the recent search history. The
search history displays a maximum of 15 search expressions. Select the criteria, click
Show recent criteria, and then click Add.

+ Show Tags: You can search events that have a particular tag. Click Show Tags, that
lists the tags in the system. Select the tags, and then click Add.

+ Show Filters: You can reuse existing filters to perform a new search. Click Show
Filters that lists the existing filters. Select the filter on which you want to perform the
search, and then click Add.

You can combine multiple criteria, tags, or filters by using the And or Or condition.
(Optional) Select a time period for the search.
¢ The defaultis Last 1 hour.

+ Custom allows you to select a start date and time and an end date and time for the query.
The start date should be earlier than the end date, and the time is based on the machine’s
local time.

+ Whenever searches all available data, without any time constraints.

(Optional) If you have administrator privileges, you can select other Sentinel servers for the
search.

If you have data federation configured, you can perform a search on other Sentinel servers. For
more information, see “Configuring Data Federation” in the NetlQ Sentinel Administration Guide.

Click Search.

The search results are displayed. For information on the search results, see Section 3.2,
“Viewing Search Results,” on page 35.

(Optional) Modify the search criteria by clicking Edit Criteria.
(Optional) Modify the search results by selecting the desired event fields in the search results

To add an AND or Or condition to the existing criteria, left-click the event field, select the required
fields, and then specify the desired condition.

Click Search.
(Conditional) To save the search query, see Section 3.4, “Saving a Search Query,” on page 39.
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3.2

Viewing Search Results

Searches return a set of events. When results are sorted by relevance, only the top 50,000 events
can be viewed. When results are sorted by time, all the events in the system are displayed.

Occasionally, the search engine might index events faster than they are inserted into the data
directory. If you run a search that returns events that were not added in the data directory, you get a
message indicating that some events match the search query, but they are not found in the data
directory. If you run the search again later, the events are added to the data directory and the search
is shown as successful.

NOTE: If time is not synchronized across your server, client, and event sources, you might get
unexpected results from your search. This is especially a problem if searches are performed on time
durations such as Custom, Last 1 hour, and Last 24 hours where display results are based on the
time zone of the machine on which the search is performed.

The information in each event is grouped into the following categories:

Category Icon Description

General No icon Generic information about the event, such as severity, date, time,
product name, and taxonomy.

Initiator The source that caused the event to occur. The source can be a device,
network port, etc.

Target ® The object that is affected by the event. The object can be a file,
B database table, directory object, etc.

Observer & The service that observed the event activity.
Reporter =7 The service that reported the event activity.
Tags Noicon Tags that the events are being tagged with.
Customer value No icon Fields set by the customer.

Retention period No icon Retention period of the event.

The initiator, target, and observer can be hosts, services, and accounts. In some cases, the initiator,
target, and observer can be all the same, such as a user modifying this or her own account. In other
cases, the initiator, target, and observer can be different, such as an intrusion detection system
detecting a network attack. If an event field has no data, it is not displayed in the results.

Event fields are grouped according to the following categories:

Group Icon Description

Host @ The initiator or target host information. For example, initiator host IP, target hostname,
or target host ID.

User The initiator or target user information. For example, the initiator username, initiator
user department, target user ID, or target username.

Service oy The initiator or target service information. For example, the target service name, target
service component, or initiator service name.
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Group Icon

Description

Domain

IPCountry

Target trust

B=

Target data

Tenant name

Vulnerability w

Domain information of both the host and user. For example, the target host domain
and initiator username.

The country information of the initiator and target trust. For example, the target host
country.

The target trust and target domain information of the event that was affected. The
name can be a group, role, profile, etc.

The target data name and data container information. The data name is the hame of
the data object, such as a database table, directory object, or file that was affected by
the event. The data container is the full path for data object.

The name of the tenant that owns the event data, applied to all the events in the
inbound stream from a given Collector. The tenant name can be the name of the
customer, division, department, etc.

A flag that indicates whether Exploit Detection has matched this attack against known
vulnerabilities in the target.

Each event type is represented by a specific icon. The following table lists the icons that represent the
various types of events:

Icon Type of Event

# Audit event

/] Performance event
Anomaly event

(L] Correlation event
HE Unparsed event

You can view the search results in the summary view and in the detailed view. When you mouse over
an event field, the information about the field is displayed.

¢ Section 3.2.1, “Summary View,” on page 36

¢ Section 3.2.2, “Detailed View,” on page 36

321 Summary View

The Summary view of the search results displays the basic information about the event. The basic
information includes severity, date, time, product name, taxonomy, and observer category for the

event.

3.2.2 Detailed View

1 To view the report details, click the More link at the top right corner of the search results.
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This displays details such as host/user domain information, IPCountry information, extended
target fields like TargetTrust and TargetData, Observer and Reporter fields, customer set
variables, default data retention duration information for any individual event, and the tags set for
the event.

2 To view all the details of an event, click the All link.

3. Show more details
181747 |ssueSAMLToken (Security Event Management : Internal) g Mare | Al
2012-01-30 .

¥ 127.0.01 — TS
admin (1} "
Message: lssue SAN Name Value
184747 Authe CollectorPlugindame Audit 3
20120130 EventlD BEB5A350-2B16-102F-
W 127.0.0.1 BOE4-005056AF0614
admin (1) EventName IssueSAMLToken

Message: Uzer admi

EventTime 2012 January 30 181747 UTC+5:30

18:1A7:47 Logir

2012-01-30 InitiatorUserDomain

Sentinel68B5A350-2B16-102F-
BCO0-005056AF0614
W jalgesm4s0 (10.:

admin (1) InitiatorUseriD 1

Message: Logging in

184747 Auths
2012-01-30

InitiatorUserlame

Message

MinRetentionDate

admin

Issue SAML authorization token for
user admin.

= jalgesmdE0 (10 2012 April 30 05:30:00 UTC+5:30

admin (1) -
P ™ P =ty

Message: User admi
Close

3 To view details about all events, click the Show more details link at the top of the search results
page.

You can expand or collapse the details for all events on a page by using the Show more details
or Show less details link.

4 (Optional) Click the get raw data link to open a new Raw Data tab with event source hierarchy
and event source fields populated, based on the information received from the event.

The get raw data link is available only for users in the administrator role.
If the search result is a system or an internal event, the get raw data link does not appeatr.

To verify and download the raw data files, see “Verifying and Downloading Raw Data Files” in the
NetlQ Sentinel Administration Guide.
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3.3

Refining Search Results

The search refinement panel can be used to narrow the search results by selecting one or more
values for an event field. You can refine the results for one or more event fields.

The set of event fields that is displayed in the search refinement panel is configurable on a per-user
basis.

For performance considerations, the maximum sample size used to calculate the event field value
statistics is 50,000 events. The actual sample size is displayed in the field count label as Field
counts based on the first <sample-size> events where <sample-sizes is replaced by the
actual sampling size.

To refine search results:

1 Log in to the Sentinel Web interface.

https://<IP Address/DNS Sentinel server:8443>

IP_Address/DNS_Sentinel_server is the IP address or the DNS name of the Sentinel server and
8443 is the default port for the Sentinel server.

2 In the Reports and Searches panel, click New Search.
3 Specify the search criteria, then click Search.

For more information on how to run an event search, see “Running an Event Search” on
page 33.

Click fields in the REFINE section.The Select Event Fields window is displayed.

5 To refine the search, select the event fields from the available fields, then click Save.

The selected event fields are displayed in the REFINE panel.

A count at the right side of each event field displays the number of unique values that exist for
that event field in the data directory. The calculation is based on the first 50,000 events found.

The event field selection is on a per-user basis. Each user can have a different set of selected
event fields.

Click each event field to view the unique values for that event field.

For example, if the search results contain events that had severities 1, 2, 5, and 4, the event field
is displayed as Severity (4).

The top 10 unique values are initially displayed in the order of most frequent to least frequent.

The value next to the check box represents the unique value for that event field and the value at
the far right represents the number of times the value appears in the search result.

If there are multiple unique values occurring the same number of times in a search, the values
are sorted by the most recent occurrence of the value.

For example, if events of severity 1 and 4 occurred 34 times in the search results, and an event
of severity 4 was logged most recently, the unique value 4 appears at the top of the list.

To display the unique values in the order of least frequent to most frequent, click reverse.

When there are more than 10 unique values, you can view and filter either the top 10 or the
bottom 10 unique values. You cannot refine your search on both the conditions at the same time.
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In the following scenarios, the number of events returned from a refined search is greater than
the number of values listed for an event field:

+ If the refinement performs a new search with additional terms intersected with the initial
search string, such as by using an AND operator, the new search is run against all events in
the system, including the result set from the initial search. If new events that came into the
system match the refined search, they are shown in the resulting set and the event count is
greater than the field value count.

+ |f there are more than 50,000 events, the event field statistics are calculated only on the first
50,000 events.

There could be an event field value that occurs 50 times in the first 50,000 events, but it
could occur 1,000 times in all other stored events. In this scenario, the displayed value
count is 50, but when the search is refined with this value it returns 1,000 events.

7 Click OK.

Selected event field values are listed under the event field in the REFINE panel.

The right panel displays the refined search results, which contain only the selected values.
8 Repeat Step 4 through Step 7 to further refine the search.

9 (Optional) Click clear to clear the selected unique event field values from the REFINE panel and
to return to the original search results.

10 (Optional) Click add to search to add the refined search values to the current search tab and to
recalculate the search statistics.

If you have already added the event field value to the current search tab, clicking clear does not
return to the previous search results.

3.4 Saving a Search Query

You can save a search query, then repeat it as desired. To save a search query, you must first
perform a search. When you are satisfied with the search results, you save the search query.

NOTE: You must have the necessary permission to access the specific options. For example, only
users in the Report Administrator role can save the search query as a report template.

+ Section 3.4.1, “Saving a Search Query as a Search Template,” on page 39

+ Section 3.4.2, “Saving a Search Query as a Filter,” on page 40

*

Section 3.4.3, “Saving a Search Query as a Report Template,” on page 40

*

Section 3.4.4, “Saving a Search Query as a Routing Rule,” on page 43

*

Section 3.4.5, “Saving a Search Query as a Retention Policy,” on page 43

*

Section 3.4.6, “Creating a Dashboard,” on page 44

3.4.1 Saving a Search Query as a Search Template

1 Perform and refine a search until you are satisfied with the search results.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 Click Save as, and then click Save search.
3 Specify a unique name for the search and provide an optional description.
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4 Specify the following information in the Default Parameters section:

Data sources: Displays the number of servers that Sentinel will search for events. This option is
useful if data federation is enabled. To select the data sources you want to search, click selected
data sources, then select the data sources.

Email to: To e-mail the report template to others, specify the e-mail address. To send the report
template to more than one person, specify multiple e-mail addresses separated by a comma.

Result limit: Specify the number of results to be stored in the search template. By default, 1000
results are stored in a report template.

5 Click Save.

3.42 Saving a Search Query as a Filter

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 When you are satisfied with the search results, click Save as, then click Save search as filter.
3 Specify a unique name for the filter and an optional description.
4 In the drop-down list, select one of the following options to specify the access for this filter:
+ Private: Allows you to make this filter private. Other users cannot view or access this filter.
+ Public: Allows you to share this filter with all users.

+ Users in same role: Allows you to share this filter with users who have the same role as
yours.

+ Users in selected roles: Allows you to share this filter with users in specific roles. If you
select this option, a blank field is displayed where you can specify the roles. As you type the
role name, a list of roles is displayed.

Select one or more roles.

NOTE: This option is available only for users in the administrator role.

5 Click Save.

The saved filter is listed in the Filters panel. For more information on filters, see Chapter 4,
“Configuring Filters,” on page 49.

3.43 Saving a Search Query as a Report Template

You can save the search query as a search report.

NOTE: You must have the Manage Reports permission to save the search query as a report
template.

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 When you are satisfied with the search results, click Save as, then click Save search as report.
3 Specify the following parameters:
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Parameter

Description

Report name

Specify a unique name for the report. The name should not exceed 200
characters.

Based on Select the base report from which you want to create the report.
You can view a sample report by clicking the View Sample button.
Description The description is automatically displayed based on the report that is
selected and you can edit the description.
Criteria Criteria is automatically populated based on the report selected and is

not editable.

Additional criteria

Specify additional search criteria to the existing criteria. To build a new
criteria on your own, click Edit Criteria. To build a new criteria from
available system objects containing criteria, click Add Criteria.

The criteria that you add here is appended to the existing criteria.

Data sources

Select the source machines on which the reports can be run by clicking
the selected data sources link. You can select data sources only if
your Sentinel is configured for data federation.

For more information, see “Configuring Data Federation”in the NetlQ
Sentinel Administration Guide.

Additional Criteria

Specify additional criteria to refine the results. The criteria that you
specify here can be edited while scheduling the report. If you specify
Criteria name, the name is displayed at the end of the report results.

NOTE: This parameter is not available for all reports.

Time Zone

Specify the time zone with which you want to populate the report. When
you schedule the report, the time zone that you specify here is
displayed in the report data.

For example, if the Time Zone is set to US/Pacific-New time, the report
data displays the selected time zone.

By default, it displays the time zone that is set in the client system.

NOTE: This parameter is not available for all reports.
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Parameter Description

Date Range If the report includes time period parameters, choose the date range.
All time periods are based on the local time for the browser. The From
Date and the To Date automatically change to reflect the option you
selected.

¢ Current Day: Shows events from midnight of the current day until
11:59:00 PM of the current day. If the current time is 8:00:00 AM,
the report shows 8 hours of data.

¢ Previous Day: Shows events from midnight yesterday until
11:59:00 PM yesterday.

* Week To Date: Shows events from midnight Sunday of the
current week until the end of the selected day.

+ Previous Week: Shows events for the last seven days.

* Month to Date: Shows events from midnight the first day of the
current month until the end of the selected day.

+ Previous Month: Shows events for a month, from midnight of the
first day of the previous month until 11:59:00 PM. of the last day of
the previous month.

¢ Custom Date Range: Shows events for a period whose start and
end date are chosen. If you select Custom Date Range, set the
start date (From Date) and the end date (To Date) for the report.

Group By Group the events according to specific event field by selecting the
event field from the Group by drop-down list.

NOTE: This parameter is not available for all reports.

Language Choose the language in which the report labels and descriptions should
be displayed. The possible values are English, French, German, Italian,
Japanese, Traditional Chinese, Simplified Chinese, Spanish, or
Portuguese.

The default value is the language with which the current user logged in,
if that language is supported by the report. If the report does not
support the language, the report’s default language (typically English)
is used.

The data in the report is displayed in the language that was originally
used by the event source.

Email to Specify an e-mail address in the Email to field. If you want to mail the
report to more than one user, separate the e-mail addresses with a
comma.

Result limit Specify the number of results to be displayed or stored when you run or

schedule the report. By default, 1000 results are stored.

If you specify a value in Group By field, the result limit is based on
grouping.

4 Click Save to save the search as report definition.

You can see the saved report definition in the Reports and Searches panel in the Sentinel Web
interface. To view the reports, see “Viewing Events” on page 132.
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3.44 Saving a Search Query as a Routing Rule

You must be in the administrator role to save the search query as a routing rule.

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 When you are satisfied with the search results, click Save as, then click Save search as routing
rule.

3 Specify a name for the rule.

4 (Conditional) To associate one or more tags to the events, click Select tag, select the desired
tags, then click Set.

5 Select where you want to route the events to:

+ All: Events are routed to all Sentinel services, including Correlation and Security
Intelligence.

+ Event store only: Events are sent directly to the event store, and are not displayed in
Active Views and the search results page.

+ None (drop): Events are dropped or ignored, and are not sent to any Sentinel service.

6 Select one or more actions to be performed on each event that meets the search criteria. Click
the plus and minus icons to add and remove actions.

7 Click Save.

345 Saving a Search Query as a Retention Policy

You must be in the administrator role to save the search query as a retention policy.

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 When you are satisfied with the search results, click Save as, then click Save search as
retention policy.

3 Specify a name for the retention policy.

4 In the Keep at least field, specify the minimum number of days to retain the events in the
system. The value must be a valid positive integer.

5 (Optional) In the Keep at most field, specify the maximum number of days for which the events
should be retained in the system.

The value must be a valid positive integer and must be greater than or equal to the Keep at
least value. If no value is specified, the system retains the events in the system until the space is
available in primary storage.

6 Click Save.

The newly created policy is displayed in the data retention table. For more information on
retention policies, see “Configuring Data Retention Policies” in the NetlQ Sentinel Administration
Guide.
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3.4.6 Creating a Dashboard

You must have the Manage and View Security Intelligence Dashboards permission to create a
dashboard.
1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 When you are satisfied with the search results, click Save as, then click Save search as
dashboard.

3 Specify the following information to create the dashboard:
+ Name: Specify a unique name for the dashboard.

+ Classifier: Select the classifier that determines the categories displayed in the dashboard.
Click the Info link for information on each category.

+ Data Retention Period: Select how long the data for the dashboard is retained.
4 Click Create dashboard to create the dashboard.

The dashboard is displayed in a new browser tab. A new dashboard is empty because it has not had
time to collect any data. For more information on dashboards, see Chapter 7, “Analyzing Trends in
Data,” on page 93.

3.5 Performing Event Operations

You can use the events in the search results to perform various tasks as you view the search results.

¢ Section 3.5.1, “Executing Actions,” on page 44

+ Section 3.5.2, “Exporting the Search Results to a File,” on page 45

+ Section 3.5.3, “Adding Events to an Incident,” on page 45

+ Section 3.5.4, “Creating an Incident,” on page 46

¢ Section 3.5.5, “Adding Events to a Correlation Rule,” on page 46

+ Section 3.5.6, “Creating a Correlation Rule by Using Events,” on page 46
+ Section 3.5.7, “Viewing ldentity Details of Events,” on page 47

+ Section 3.5.8, “Viewing Advisor Report,” on page 47

+ Section 3.5.9, “Viewing Asset Data,” on page 47

¢ Section 3.5.10, “Viewing Vulnerabilities,” on page 48

3.5.1 Executing Actions

Only users in the following roles can execute actions on events:

+ Administrator

+ Incident Administrator

¢ Security Policy Administrator
+ User

To execute actions on events:

1 Perform a search, and refine the search results as desired.
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3.5.2

3.5.3

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events on which you want to execute actions.
3 Click Event operations > Show action panel.
4 In the Event Actions panel > Actions field, select the desired actions, then click Execute.

The results of the actions are displayed in the Results field. For more information on executing
actions, see Chapter 11, “Manually Performing Actions on Events,” on page 117.

Exporting the Search Results to a File

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events you want to export to a file.
3 Click Event operations > Export to file.
4 Specify the following information:
File Name: Specify a name for the file to which you want to export the search results.

Event Limit: Specify the maximum number of events to be saved. The event limit must be less
than the number of events you selected and the maximum event limit is 200000.

All the search results are written into a . csv file. These files are then compressed into a . zip file
for downloading.

5 (Optional) You can remove the event fields that you do not want to export to the file. Click
Choose Fields, then clear the selections for the fields that you do not want to export to the file.

By default, the null fields are excluded and not exported to file.
6 Click Export to export the search result to a file.

A download file dialog box is displayed with an option to open or save the . zip file.
7 Select the desired option, then click OK.

Adding Events to an Incident

You must have the View or Create Incidents and Add Events to Incidents permission to add events to
incidents.

For more information on Incidents, see Chapter 16, “Configuring Incidents,” on page 143.

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events you want to add to an incident.
3 Click Event Operations > Add to incident.

NOTE: Ensure that incidents are available. If there are no incidents available, then you need to
create one. For more information on creating incidents seeSection 3.5.4, “Creating an Incident,”
on page 46.

4 Click Search to view all the available incidents.
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3.54

3.55

3.5.6

5 (Optional) To view incidents based on categories, select a category from the GroupBy drop-
down list.

6 Select the incident to which you want to add events.
7 Click OK.

Creating an Incident

You can create an incident from a group of events representing something of interest. For example,
group together similar events or group together a set of different events that indicate a pattern of
interest such as an attack.

You must have the View or Create Incidents and Add Events to Incidents permission to create
incidents.

For more information on Incidents, see Chapter 16, “Configuring Incidents,” on page 143.
To create an incident from events:

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events you want to add to an incident.

3 Click Event operations > Create incident.

4 Use the following information to create the incident:
Title: Specify a title for the incident.
Description: Specify a description of the incident.
Severity: Select the severity of the incident from the drop-down list.
Priority: Select the priority of the incident from the drop-down list.
Category: Select the category of the incident from the drop-down list.
Responsible: Select the user that is responsible to investigate and close the incident.
iTRAC: Select an iTrac workflow to use to manage the incident.

5 Click OK to create the incident.

Adding Events to a Correlation Rule

You must have the Manage Correlation Engine and Rules permission to create a Correlation rule. For
more information on creating a Correlation rule by using events, see Section 5.4.6, “Creating
Correlation Rules From Search Results,” on page 74.

Creating a Correlation Rule by Using Events

You must have the Manage Correlation Engine and Rules permission to create a Correlation rule. For
more information on creating a Correlation rule by using events, see Section 5.4.6, “Creating
Correlation Rules From Search Results,” on page 74.
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3.5.7 Viewing Identity Details of Events

If Sentinel is integrated with Identity Management systems, you can view the user identity details of
events. You must have the View People Browser permission to view the Identity details.
1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events for which you want to view the identity details.
3 Click Event operations > Show identity details.

4 Select whether you want to view the identity of the Initiator user, the Target user, or both.

For more information on identity details, see Chapter 10, “Leveraging Identity Information,” on
page 113.

3.5.8 Viewing Advisor Report

The following are the prerequisites to view the Advisor data:

+ The Advisor feed must be up-to-date, processed, and loaded into the Sentinel database.

+ The selected event must be from a product supported by Advisor and it must have the
Vulnerability field value set to 1.

To view the Advisor data:

1 Click Filters > Exploit Detected Events or specify vul:1 in the Search field, then click Search.
All events that are likely to have exploited a known vulnerability are displayed.

2 In the search results, select the events for which you want to view the Advisor data.

3 Click Event operations > View Advisor report.
The Advisor report is displayed in a new tab.

For more information on Advisor, see “Detecting Vulnerabilities and Exploits” in the NetlQ
Sentinel Administration Guide.

359 Viewing Asset Data

You must have the View Asset Data permission to view the asset data of the selected events. You can
view the asset information related to a machine or device from which you are receiving events. To
view the asset data, you must run the asset management Collector and ensure that the asset data is
being added to the Sentinel database.

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events for which you want to view the asset data.
3 Click Event operations > View assets.
The asset data is displayed in a new tab.

For more information on asset data, see “Viewing Asset Data” on page 27.
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3.5.10 Viewing Vulnerabilities

You must have the View asset vulnerability data permission to view the Vulnerability data. You can
view the vulnerabilities of the selected destination systems. To view the Vulnerability data, you must
run the Vulnerability Collector and ensure that the Vulnerability scan information is being added to the
Sentinel database.

Vulnerabilities can be seen for the current time or for the event time.
+ View Vulnerabilities at current time: This report queries the database for vulnerabilities that
are active (effective) at the current date and time, and displays the relevant information.

+ View Vulnerabilities at time of event: This report queries the database for vulnerabilities that
were active (effective) at the date and time of the selected event, and displays the relevant
events.

To view the Vulnerability report:

1 Perform a search, and refine the search results as desired.

For more information, see Section 3.1, “Running an Event Search,” on page 33 and Section 3.3,
“Refining Search Results,” on page 38.

2 In the search results, select the events for which you want to view the Vulnerability data.

3 (Conditional) To view vulnerabilities at the current time, click Event operations > View
Vulnerabilities at current time.

4 (Conditional) To view vulnerabilities at the time of the event, click Event operations > View
Vulnerabilities at time of event.

For more information on the vulnerability data, see “Viewing Vulnerabilities” on page 28.

48 NetlQ Sentinel User Guide



4.1

4.2

Configuring Filters

¢ Section 4.1, “Overview,” on page 49

¢ Section 4.2, “Introducing the Filters Interface,” on page 49
+ Section 4.3, “Creating a Filter,” on page 52

+ Section 4.4, “Sample Filters,” on page 54

+ Section 4.5, “Viewing Events by Using Filters,” on page 56
+ Section 4.6, “Managing Filters,” on page 56

Overview

The Filters feature in Sentinel allows you to customize the event search and prevent data overload.
This feature provides a Add or Edit criteria dialog that helps you build search queries ranging from
simple to complex. You can save a search query as a filter and reuse it as required, so you can
perform a search by selecting the filter rather than specifying the query manually every time.

You can reuse filters while using or configuring Sentinel features, such as:
+ Configuring Data Synchronization. For more information, see “Configuring Data
Synchronization” in the NetlQ Sentinel Administration Guide.

+ Configuring a Data Retention policy. For more information, see “Configuring Data Retention
Policies” in the NetlQ Sentinel Administration Guide.

+ Configuring the data visibility settings for a role. For more information, see “Creating a Role” in
the NetlQ Sentinel Administration Guide.

+ Creating dashboards. For more information, see Section 7.2, “Creating a Dashboard,” on
page 96

+ Configuring event routing rules. For more information, see “Configuring Event Routing Rules” in
the NetlQ Sentinel Administration Guide.

+ Viewing real-time events in Active Views. For more information, see Chapter 2, “Viewing Events
in Real-Time,” on page 17.

Sentinel provides a list of filters by default. You can also create your own filters.

Introducing the Filters Interface

+ Section 4.2.1, “Filters Panel,” on page 50
+ Section 4.2.2, “Filter Criteria,” on page 50
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Filters Panel

To access the Filters panel, click Filters in the navigation panel on the left of the Sentinel Web
interface. The Filters panel lists the default filters, filters you create, and the filters that other users
have shared with you.

The Filters panel includes the following:
+ Find Filters: Allows you to search the specified filter. Specify the filter name, description of the
filter, or keywords to search for a filter.
+ Create: Launches the filter similar to search that allows you to specify the filter criteria.
+ My Filters: Lists the default filters and the filters you created.
+ Shared Filters: Lists the filters that other users have shared with you.

To view events based on filters, select the desired filter. The associated events are displayed in the
search results panel.

Filter Criteria

You can specify the filter criteria by using either the Add Criteria or Edit Criteria dialog.

Add Criteria

Creating a filter is similar to performing a search. For more information, see Section 3.1, “Running an
Event Search,” on page 33.

The Add Criteria provides the predefined criteria list from which you can select the required criteria.
You can filter the criteria based on recent criteria, tags, or filters.

+ Show only recent criteria: Select a search criterion from the recent search history. The search
history displays a maximum of 15 search expressions. Select the criteria, click Show only
recent criteria, and then click Add.

+ Show only tags: You can search events that have a particular tag. Click Show only tags to list
the tags in the system. Select the tags, and then click Add.

+ Show only filters: You can reuse existing filters to perform a new search. Click Show only
filters to list the existing filters. Select the filter on which you want to perform the search, and
then click Add.

You can combine multiple criteria, tags, or filters by using the And or Or condition. After adding the
criteria, you can test the filter by clicking Test Filter.

Edit Criteria

The Edit Criteria provides a list of parameters required to build search criteria ranging from simple to
complex. You can either select the parameters, or you can manually specify the search criteria.

For information on building search queries, see Appendix A, “Search Query Syntax,” on page 181.
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The Edit Criteria dialog box includes the following elements:

Table 4-1 Edit Criteria Dialog Box Elements

Element Description

Criteria If you select Structured, this field displays the criteria formed by the parameters you
select. You cannot modify or specify the filter criteria.
If you select Free-form, you can manually specify the filter criteria.

Structured Allows you to select the various parameters to build the filter criteria.

Free-form Allows you to manually specify the filter criteria rather than selecting from the

Exclude system events

Event fields

Criteria fields

available parameters.

The search criteria is based on the standard Lucene syntax with some Sentinel
extensions. For information on creating a filter criteria (search query), see
Appendix A, “Search Query Syntax,” on page 181.

If this option is selected, the following elements are not displayed:

+ Event fields
+ Criteria fields
+ Field details

Select this option to exclude Sentinel internal events such as audit events and
performance events from the search results.

Displays a categorized list of possible event fields you can add to the filter criteria.
You can expand each category to display the set of fields in that category. If you
know the name of the field you want, specify the name in the Search field. The event
category list will adjust to present only matching fields.

For more information on event fields, click Tips located at the top right of the
Sentinel Web interface.

Lists a set of overlay criteria that you can use on top of per-field searches. The
following fields are displayed by default:

+ All data: Performs a search across all event fields.
For more information, see Section A.1.4, “The Default Search Field,” on
page 183 in Appendix A, “Search Query Syntax,” on page 181.

+ Tags: Events can be tagged in various ways to help identify relationships
between events. Queries that include a “Tags” search will look at the event tags
(rv145) for matches.

+* Taxonomy: Events are also classified using a number of taxonomic categories
for the action, outcome, and so on. Queries that include a “Taxonomy” search
will search for specific classes of events.

For more information on taxonomy, see Sentinel Taxonomy.
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Element Description

Field details The fields in this section vary depending on the event or criteria fields you select. For
example:

* For tokenized fields, you can specify the words that you want to include or
exclude in the filter criteria. For information on the tokenized and non-tokenized
fields, click Tips located at the top right of the Sentinel Web interface.

+ For non-tokenized fields, you can specify a value or a range of values.
+ For taxonomy fields, specific taxonomy options are displayed.

+ For date attributes, a date-time calendar is displayed as you type the date. You
can select a date.

+ For fields that contain internal Sentinel UUIDs, such as the CollectorlD field,
the corresponding Sentinel object names are displayed and can be selected.

Condition: AND OR Allows you to specify the AND or OR condition between the criteria fields. These
options are available when you add additional event criteria to the criteria fields.

Cancel Allows you to cancel the filter creation process.

Search Runs a search to test the filter before saving it.

4.3 Creating a Filter

Filter expressions are simple math expressions and simple evaluations. Filters work on selection sets
by matching events against the specified criteria. If the match is TRUE, the event is displayed in
Active Views or search results, or passed to other functions. If the match is FALSE, the event is
blocked.

For example, consider a search query that is written as follows:

(sip:"10.0.0.1")

Events whose source IP address is 10.0.0.1 are included in the filter.

You must use the event field ID to represent an event name. Click the Tips link on the top right of the
Sentinel Web interface for a list of event field names and their IDs.

For more information building search queries, see Appendix A, “Search Query Syntax,” on page 181.

While creating a filter, you can specify whether you want to share a filter with other users. You must
have the Share Search Filters permission to share filters with everyone or with users in the same role
as yours. If you are a user in the administrator role, you can share filters with users in a different role.

You can create filters either by using the Add or Edit Criteria dialog or by using the Save as icon in the
Search panel.

+ Section 4.3.1, “Creating a Filter by Using the Edit Criteria Dialog,” on page 52
+ Section 4.3.2, “Creating a Filter by Using a Search Query,” on page 53

43.1 Creating a Filter by Using the Edit Criteria Dialog

1 Log in to the Sentinel Web interface.

https://<IP _Address/DNS _Sentinel server:8443>
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4.3.2

IP_Address/DNS_Sentinel_server is the IP address or DNS name of the Sentinel server and
8443 is the default port for the Sentinel server.

2 In the navigation panel, click Filters > Create.
3 Select one of the following methods to create a search criteria:

+ To build the search criteria by selecting parameters, make sure that Structured is selected,
select the parameters, then continue with Step 4.

For information on these parameters, see Table 4-1, “Edit Criteria Dialog Box Elements,” on
page 51.

+ To manually specify the search query rather than selecting the listed parameters, select
Free-form. In the Criteria field, specify the search query, then continue with Step 4.

For information on creating a search query, see Appendix A, “Search Query Syntax,” on
page 181.

4 (Conditional) If you do not want to include Sentinel internal events in the search, select Exclude
system events.

5 Click Search to search events according to the specified filter criteria.
By default, the search is performed on events that were generated within the last 1 hour.
6 Review the search results to verify that the filter is retrieving the expected events.
7 (Optional) You can modify the search query by selecting one or more event field values from the
search results, or you can click Edit search filter, then make necessary changes.
8 When you are satisfied with the search results, click El'v, then click Save as new filter.
9 Specify a name for the filter and an optional description.
10 In the drop-down list, select one of the following options to specify the access for this filter:
+ Private: Allows you to make this filter private. Other users cannot view or access this filter.
+ Public: Allows you to share this filter with all users.

+ Users in same role: Allows you to share this filter with users who have the same role as
yours.

+ Users in selected roles: Allows you to share this filter with users in specific roles. If you
select this option, a blank field is displayed where you can specify the roles. As you type the
role name, a list of roles is displayed.

Select one or more roles.

NOTE: This option is available only for users in the administrator role.

11 Click Save.

Creating a Filter by Using a Search Query

You can save a search query as a filter and use this filter to perform searches when required rather
than specifying the search query again. For more information on creating a filter by using a search
query, see Section 3.4.2, “Saving a Search Query as a Filter,” on page 40.
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4.4.2

Sample Filters

This section lists a few examples on how you can create filters.

+ Section 4.4.1, “View Events of Severity 3 to 5 from a System in China,” on page 54

+ Section 4.4.2, “Determine if User “Bob Smith” Tried to Log In after His Account was Disabled,”
on page 54

+ Section 4.4.3, “View Events from Two Subnets and Share the Filter with Network
Administrators,” on page 55

+ Section 4.4.4, “Find all Events that Include the Words “database” and “service,” and exclude

”

“test”,” on page 55

View Events of Severity 3to 5 from a System in China

+ In the Edit Criteria > Event fields, select SourceHostCountry.

For more information on the Filter Criteria, see Section 4.2.2, “Filter Criteria,” on page 50.

+ The name should match any string that contains the name “China.” For example, “ChinaBeijing.”
Specify china* in the Value field.
+ The severity of the events must be 3 to 5:
+ In Event fields, select Severity.

+ Inthe Values that range from field, specify 3 TO 5.

NOTE: If you are familiar with the search query syntax, you can directly specify the query in the
Criteria field as follows:

(rv29:china*) AND (sev:[3 TO 5])

For more information on the search query syntax, see Appendix A, “Search Query Syntax,” on
page 181.

Click Search to view events that match the specified criteria.

Determine if User “Bob Smith” Tried to Log In after His
Account was Disabled

+ In the Edit Criteria > Event fields, select the following:
¢ InitiatorUserName
+ TargetUserName
+ EffectiveUserName

For more information, see Section 4.2.2, “Filter Criteria,” on page 50.
+ Select the OR condition.
+ Specify "Bob Smith" in the Value field.
+ To determine if the user has logged in, or tried to log in, select Taxonomy in Criteria fields.
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NOTE: You can also select the appropriate event fields if you are familiar with the values to be
specified for the event fields. Taxonomy is a classification of events where events of similar type
are grouped together. It helps you search events based on the taxonomy classification rather
than you specifying the specific event names and their values.

+ In the Field details, select the following:
+ From the Class drop-down list, select User Session Events.
+ From the Identifier drop-down list, select Create.

* For Outcome, select Success, then select Failure.

NOTE: If you are familiar with the search query syntax, you can directly specify the query in the
Criteria field as follows:

(xdasclass:2 AND xdasid:0 AND (xdasoutcome:0 OR xdasoutcome:1)) AND (iufname:"Bob
Smith")

For more information on taxonomy, see Sentinel Taxonomy.

Click Search to view the events that match the specified criteria.

443 View Events from Two Subnets and Share the Filter with
Network Administrators

+ Select subnets:
+ In Edit criteria > Event fields, select SourcelP.
+ In Field details > Value, specify the subnet, for example, 172.17.0.0/16.
+ Repeat the above two steps to specify another subnet.
The events must be from either of the subnets. Therefore, select OR as the condition.

*

*

Click Search to view events that match the specified criteria.
The filter must be shared with network administrators:

*

¢ In the search results panel, click E'L-, then click Save as new filter.

+ Specify an intuitive name and an optional description.

+ From the drop-down list, select Share with roles, then select Network Administrator.
Click Save.

*

444 Find all Events that Include the Words “database” and
“service,” and exclude “test”

+ |n Edit Criteria > Criteria fields, select All data.

+ You want to find events that include words “database” and “service,” and exclude “test.”
Therefore, in Field details, specify the following:

+ Inthe All of these words field, specify database service.

¢ In the Exclude these words field, specify test.

NOTE: If you are familiar with the search query syntax, you can directly specify the query in the
Criteria field as follows:
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_data: (database AND service) NOT data:test

The data field allows you to search for words that might appear in any event field. For more
information, see “The Default Search Field” in Appendix A, “Search Query Syntax,” on page 181.

Click Search to view the events that match the specified criteria.

4.5 Viewing Events by Using Filters

You can use filters to view events either by selecting the desired filter in the Filters panel or by using

the Filter ® icon in the search results panel. For more information, see Chapter 3, “Searching
Events,” on page 33.

46 Managing Filters

You can edit and delete only the filters that you created. The default filters and the filters that other
users have shared with you cannot be edited or deleted.

+ Section 4.6.1, “Editing a Filter,” on page 56

* Section 4.6.2, “Deleting a Filter,” on page 56

4.6.1 Editing a Filter

1 Inthe Sentinel Web interface, select Filters, then select the filter that you want to edit.
The filter criteria are displayed in the search results panel.

2 (Conditional) To edit the filter name, description, or the filter type, click Edit.

3 Make the necessary changes, then click OK.

4 (Conditional) To edit the filter criteria, click Edit search filter.

For more information on the criteria you can select, see Section 4.2.2, “Filter Criteria,” on
page 50.

5 Make the necessary changes, then click Search.

6 Click E'L, then select Save <filter_name> filter.

4.6.2 Deleting a Filter

1 Inthe Sentinel Web interface, select Filters > My filters, then select the filter that you want to
delete.

2 Click 0.
3 Click Delete to confirm deletion.
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5.1

Correlating Event Data

A single event viewed in the system might not necessarily draw your attention. But when you
correlate a set of similar or comparable events in a given period, you might identify a potential
problem. Sentinel helps you correlate events by using the rules you create and deploy in the
Correlation Engine, so you can take appropriate action to mitigate any problems.

¢ Section 5.1, “Overview,” on page 57

¢ Section 5.2, “Accessing the Correlation User Interface,” on page 62

+ Section 5.3, “Understanding the Correlation Interface,” on page 63

¢ Section 5.4, “Creating Correlation Rules,” on page 68

+ Section 5.5, “Associating Actions to a Rule,” on page 75

+ Section 5.6, “Testing a Correlation Rule,” on page 75

¢ Section 5.7, “Sample Correlation Rules,” on page 76

+ Section 5.8, “Deploying Rules in the Correlation Engine,” on page 78

+ Section 5.9, “Viewing Correlated Events,” on page 78

¢ Section 5.10, “Customizing Correlated Event,” on page 79

¢ Section 5.11, “Managing Correlation Rules,” on page 79

¢ Section 5.12, “Managing the Correlation Engine,” on page 81

Overview

Correlation adds intelligence to security event management by automating analysis of the incoming
event stream to find patterns of interest. Correlation allows you to define rules that identify critical
threats and complex attack patterns so that you can prioritize events and initiate effective incident
management and response.

¢ Section 5.1.1, “How Correlation Works,” on page 58

+ Section 5.1.2, “Correlation Rules,” on page 58

¢ Section 5.1.3, “Correlation Engine,” on page 62

Correlating Event Data
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5.1.1

5.1.2

How Correlation Works

The following illustration shows how Correlation works:

Figure 5-1 Correlation Workflow
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The Correlation Engine processes events from the real-time event stream to determine whether
they should trigger any of the active rules to fire the associated actions.

5. If events match the rule criteria, correlation events are generated and associated actions are
executed.

Sentinel’s correlation is near real-time and depends on the time stamp of the individual events. When
an event arrives at the Correlation Engine, the engine reorders the events in a buffer based on the
event time stamp (dt) field so that the events are evaluated in time order. This is done partly to
evaluate sequence rules in which the rule only fires if events occur in a specific order.

The buffer is 30 seconds long, so if the event time stamp (dt) is more than 30 seconds older than the
Collector Manager time stamp, the event is not evaluated. To minimize false time differences, you
must use an NTP (Network Time Protocol) server to synchronize the time settings on the relevant
machines. For more information, see “Configuring Time” in the NetlQ Sentinel Installation and
Configuration Guide.

Correlation Rules

Correlation rules define a pattern of events that should trigger a rule. You can create rules that range
from simple to extremely complex. For example:

+ High severity event from a finance server

+ High severity event from any server brought online in the past 10 days

+ Five failed logins in 2 minutes
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+ Five failed logins to the same server from the same username in 2 minutes

+ Intrusion detection event targeting a server, followed by an attempted login to root originating
from the same server within 60 seconds

A rule can have one or more subrules:

+ “Simple Rule” on page 59

+ “Sequence Rule” on page 59
+ “Composite Rule” on page 60
+ “Free-form Rule” on page 61

Simple Rule

A simple rule has just one subrule. You can specify additional criteria if you want the rule to fire when
all or any of the specified criteria are met. You can also specify the number of times the event should
occur for the rule to fire. For example, to monitor a situation with five failed logins within a minute on a
finance server, you can define a simple rule, as shown in the following figure:

Figure 5-2 Simple Rule
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For information on creating a simple rule, see Section 5.4.2, “Creating a Simple Rule,” on page 70.

Sequence Rule

A sequence rule has two or more subrules that fire in a sequence. You can use a sequence rule when
you want the rule to fire if its subrules meet the specified criteria in the specified sequence within the
defined time frame. For example, to monitor a situation where there has been a successful login after
three failed logins by the same user within five minutes, you can define the rule as shown in the
following figure:
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Figure 5-3 Sequence Rule
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A sequence rule can also fire even when a single event can satisfy multiple or all of the subrules
within the time frame and the times at which they were satisfied are in ascending order. For
information about creating a sequence rule, see Section 5.4.3, “Creating a Sequence Rule,” on
page 71.

Composite Rule

A composite rule has two or more subrules that fire according to the criteria you define. There are two
types of composite rules:

¢+ Composite (AND): Indicates that all subrules must fire.
+ Composite (OR): Indicates that a specified number of subrules must fire.
For example, to monitor a situation where there have been failed logins on a finance server and a

database server within two minutes, you can create a composite (AND) rule, as shown in the
following figure:
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Figure 5-4 Composite (AND) Rule
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Similarly, for example, if you have three or more subrules and you want the rule to fire if a maximum

of two subrules meet the specified criteria, you can create a composite (OR) rule, as shown in the

following figure:

Figure 5-5 Composite (OR) Rule
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A composite rule can also fire even when a single event can satisfy multiple or all of the subrules. For
information on creating a composite rule, see Section 5.4.4, “Creating a Composite Rule,” on

page 72.

Free-form Rule

If you are familiar with the rule expression syntax, you can create Correlation rules by manually
specifying the rule expression. You can use free-form rules to create complex rules by using
additional operators such as Window, Intersection, and Union.

For information on the rule expression syntax, see Appendix B, “Correlation Rule Expression Syntax,”

on page 193.

For more information on creating a free-form rule, see Section 5.4.5, “Creating a Free-Form Rule,” on

page 74.
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5.2

Correlation Engine

To monitor events according to the Correlation rules, you must deploy the rules in the Correlation
Engine. When an event occurs that satisfies the rule criteria, the Correlation Engine generates a
correlation event describing the pattern.

NOTE: Events that are sent directly to the event store or dropped by event routing rules are not
processed by the Correlation Engine.

The Sentinel Correlation Engine provides specific advantages over database-centric Correlation
Engines.

+ By relying on in-memory processing rather than database inserts and reads, the Correlation
Engine performs during high steady-state volumes as well as during event spikes when under
attack, which is the time when correlation performance is most critical.

+ The correlation volume does not slow down other system components, so the user interface
remains responsive, especially with high event volumes.

+ The Correlation Engine can add events to incidents after an incident has been created.

+ You can deploy multiple Correlation Engines, each on its own server, without the need to
replicate configurations or add databases. The Correlation Engine is built with a pluggable
framework that allows the addition of new Correlation Engines. Independent scaling of
components provides cost-effective scalability and performance.

NOTE: You cannot install more than one Correlation Engine on a single system. You can install
additional Correlation Engines on remote systems, and then connect them to the Sentinel server.

For more information about installing the Correlation Engine, see “Installing Collector Managers
and Correlation Engines "in the NetlQ Sentinel Installation and Configuration Guide.

Accessing the Correlation User Interface

NOTE: You must have the Manage Correlation Engine and Rules permission to access the
Correlation interface.

1 Log in to the Sentinel Web interface as a user with the Manage Correlation Engine and Rules
permission.
https://<IP _Address/DNS _Sentinel server:8443>

IP_Address/DNS_Sentinel_server is the IP address or DNS name of the Sentinel server and
8443 is the default port for the Sentinel server.

2 In the navigation panel, click Correlation.
The Correlation panel is displayed. For more information, see Section 5.3.1, “Correlation Panel,”
on page 63.

You can also access the Correlation user interface from the search results panel. For information on
creating Correlation rules from the search results panel, see Section 5.4.6, “Creating Correlation
Rules From Search Results,” on page 74.
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Understanding the Correlation Interface

The Correlation interface includes the following:

¢ Section 5.3.1, “Correlation Panel,” on page 63

+ Section 5.3.2, “Correlation Rule Builder,” on page 64

Correlation Panel

The Correlation panel lists the rules and the Correlation Engines installed on your system.
The Correlation panel includes the following options:

+ “Search Field” on page 63
+ “Create Link” on page 63
+ “More Link” on page 63

+ “Rules” on page 63

+ “Engines” on page 64

Search Field

The Search @ field allows you to search for the specified rule in your system.

Create Link

The Create link launches the Correlation Rule Builder that helps you to create correlation rules.

More Link

The More link allows you to select multiple rules to delete them.

Rules

The Rules section lists all the available rules in the system. The icon next to the rule indicates the
status of the rule:
+ Enabled ©: The rule is deployed in the Correlation Engine and is enabled to process events.

+ Disabled ©: The rule is deployed in the Correlation Engine, but the rule is disabled and is not
processing events.

+ No icon: The rule is not deployed in the Correlation Engine.

To view the details of any rule, click the rule. When you select or click any rule, the following icons are
displayed:

¢ Search 9.: Searches for the events that meet the rule criteria. The events are displayed in the
search results panel.
+ Edit # : Allows you to edit the rule.

+ Delete fi: Allows you to delete the rule.
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Engines

The Engines section lists the Correlation Engines installed in the system. The icon next to the
Correlation Engine indicates the status of the Correlation Engine.
+ Start £2: The Correlation Engine is started and is processing the deployed correlation rules.

+ Stop O: The Correlation Engine is stopped. When the Correlation Engine is stopped, all in-
memory data is preserved and no new correlation events are generated.

+ Offline 8: The remote Correlation Engine is off.

Click any engine to view the details, such as the rules deployed in this engine and information about
the engine. For more information, see Section 5.12.1, “Using the Correlation Engine Dashboard,” on
page 81.

5.3.2 Correlation Rule Builder

The Correlation Rule Builder helps you to create correlation rules and includes the following:

+ “Command Buttons” on page 64

+ “Rule Builder Elements” on page 64
¢ “Subrule Window” on page 65

+ “Expression Builder” on page 67

+ “Actions Panel” on page 68

Command Buttons

The following command buttons are available:
¢ Subrule: Adds a subrule window in the rule builder. You can add additional subrules to create a
sequence or composite rule.

+ View Rule Expression/Hide Rule Expression: Displays or hides the expression of the rule.
This is a toggle button.

+ Save Rule: Saves the rule in the Sentinel database.
+ Save As: Allows you to save the rule with another name.

+ Test Rule: Tests the rule against the events in your system. For more information, see
Section 5.6, “Testing a Correlation Rule,” on page 75.

Rule Builder Elements

Table 5-1 Common Rule Builder Elements

Element Description Action

edit Allows you to edit the rule name Click the edit link.
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Element

Description

Action

Rule type

Count

Group by

Time frame

Hr: Min: Sec

Lists the types of rules:

* Sequence
+ Composite (AND)
¢+ Composite (OR)

This list is displayed only if there is more than
one subrule.

This field is enabled only for composite (OR)
rules and if there are more than 2 subrules.

It indicates the maximum number of subrules
that should meet the specified criteria for the
rule to fire. For example, if you have 5 subrules
and you specify the Count as 3, the rule fires if
one, two, or three subrules meet the specified
criteria.

Lists the attributes you can use to group the
correlation events.

The Group by list is enabled if there are two or
more subrules.

Indicates the time within which the specified
criteria in the subrules should be satisfied for
the rule to fire.

Select an appropriate rule type for the rule
you want to create.

Specify a number or use the up/down arrow
keys to select a number.

NOTE: The value should always be less
than the number of subrules in the rule.

Select one or more attributes. For example,
to group events by username, select
initusername.

Specify the time in hours, minutes, or
seconds.

Subrule Window

The subrule window allows you to specify the expressions (criteria) for the rule and lists the various
expressions that you have created for a subrule.

Table 5-2 Subrule Window Elements

Element

Description

Action

Toggle icons EEH 5]

Group by

Count

Close icon ﬁ

form rule.

Lists the attributes you can use to group the

correlation events.

Toggles between a structured rule and a free-

Click the icon to toggle to the free-
form or structured view.

Select one or more attributes. For
example, to group events by
username, select initusername.

The Group by list is enabled only if the Count

is greater than 1.

Indicates the number of times the expressions

must meet the specified criteria for the
subrule/